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Татьяна Юрьевна Соколова
AutoCAD 2008 для студента.
Популярный самоучитель

 
Введение

 
В настоящее время существует множество графических редакторов и программ геомет-

рического моделирования. Компания Autodesk – один из ведущих производителей систем
автоматизированного проектирования и программного обеспечения для конструкторов,
дизайнеров, архитекторов. Это крупнейший в мире поставщик программного обеспечения и
услуг для промышленного и гражданского строительства, машиностроения, геоинформатики,
цифровых средств передачи информации и беспроводной связи, обслуживающий 7 000 000
пользователей.

Система AutoCAD, разработанная этой компанией, является лидирующей в мире плат-
формой программного обеспечения систем автоматизированного проектирования (САПР),
предназначенной для профессионалов, которым требуется воплощать свои творческие
замыслы в реальные динамические проекты.

AutoCAD – программа с богатой и во многом уникальной историей. Впервые она увидела
свет в 1982 году под именем MicroCAD. Первая версия AutoCAD ознаменовала начало насто-
ящей революции в автоматизированном проектировании. Сегодня AutoCAD переводится на
18 языков, ее используют в своей работе миллионы проектировщиков во всем мире на про-
цессорах в тысячи раз мощнее тех, которые были установлены на первых персональных ком-
пьютерах.

AutoCAD является постоянно развивающейся базовой средой проектирования, каждая
новая версия которой наследует все лучшее от предыдущих и направлена на решение следу-
ющих основных задач:

• повышение производительности и эффективности работы пользователей;
• обеспечение многократного использования имеющихся наработок;
• беспрепятственное сотрудничество пользователей при проектировании;
• адаптация AutoCAD к индивидуальным потребностям разработчиков объектно-ориен-

тированных задач.
Залог успеха Autodesk – мировое признание AutoCAD в качестве стандарта де-факто для

разработки продуктов и комплектующих, а также для документации.
Используя свою стратегию, направленную на помощь заказчикам в создании, органи-

зации и распространении цифровых конструкторских данных и в решении серьезных биз-
нес-проблем, Autodesk предлагает наиболее полный комплект интегрированных программ-
ных инструментов двумерного и трехмерного конструирования, что позволяет создавать более
качественные продукты, ускорять вывод изделий на рынок и добиваться максимальной нагляд-
ности проектов и максимально эффективного сотрудничества.

Благодаря выпуску AutoCAD 2008 компания Autodesk предлагает архитекторам, инже-
нерам и проектировщикам новый инструмент для еще более полного воплощения их идей в
реальность.
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От издательства

 
Ваши замечания, предложения и вопросы отправляйте по следующему адресу электрон-

ной почты: dgurski@minsk.piter.com (издательство «Питер», компьютерная редакция).
Мы будем рады узнать ваше мнение!
На сайте издательства http://www.piter.com вы найдете подробную информацию о наших

книгах.

mailto:%20dgurski@minsk.piter.com
http://www.piter.com/
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Глава 1

AutoCAD 2008. Общие сведения
 
 

Требования к системе
 

AutoCAD 2008 может работать как в автономном режиме, так и в локальной сети. Для
эффективной работы AutoCAD 2008 под управлением операционной системы Windows необ-
ходимы следующие программные и аппаратные средства:

• процессор Intel® Pentium® IV;
• операционные системы: Microsoft® Windows® ХР Professional или Home Edition (пакет

обновлений SP1 или SP2), Windows ХР Tablet PC Edition (SP2) или Windows 2000 (SP3
или SP4). Рекомендуется устанавливать и эксплуатировать AutoCAD либо на операционной
системе, локализованной на одном языке с программой, либо на англоязычной версии одной
из перечисленных систем;

• Microsoft® Internet Explorer 6.0 (пакет обновлений SP1 или более поздний);
• 512 Мбайт оперативной памяти;
• монитор VGA с разрешением не менее 1024 х 768 и поддержкой режима true color;
• 750 Мбайт свободного места на жестком диске для установки;
• привод компакт-дисков: любой (только для установки программы).
Требования к системе при использовании AutoCAD 2008 для концептуального проекти-

рования:
• процессор Intel® с тактовой частотой 3,0 ГГц и выше;
• Windows ХР Professional (пакет обновлений SP2);
• не менее 2 Гбайт оперативной памяти;
• 2 Гбайт свободного места на жестком диске, не считая места, необходимого для уста-

новки программы;
• Монитор с минимальным разрешением 1280 х 1024 и поддержкой режима true color;
• графический адаптер класса рабочих станций, снабженный не менее 128 Мбайт памяти

и поддерживающий технологию OpenGL.
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Установка AutoCAD

 
Чтобы успешно установить AutoCAD, понадобится выполнить несколько подготовитель-

ных шагов.
Для подготовки к установке следует:
• выяснить серийный номер – он должен быть напечатан на упаковке AutoCAD 2008.

В случае обновления одной из прежних версий AutoCAD требуется использовать серийный
номер предыдущей версии. Его можно либо найти на соответствующей упаковке, либо узнать,
выбрав в меню AutoCAD пункты Help → About;

• воспользоваться правами администратора локального компьютера, на который будет
установлен AutoCAD. Иметь права администратора домена при этом необязательно;

• закрыть все работающие приложения;
• отключить средства антивирусной защиты.
Установка AutoCAD выполняется с помощью специальной программы-инсталлятора,

которая переписывает файлы с компакт-дисков в папку, созданную на жестком диске компью-
тера. В ходе установки AutoCAD автоматически настраивается на работу с системным устрой-
ством указания и WHIP-драйвером монитора.
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Запуск системы AutoCAD

 
Запуск AutoCAD осуществляется следующими способами:
• на Панели задач выберите из меню Start → Programs → Autodesk → AutoCAD 2008;
• на Рабочем столе Windows дважды щелкните на пиктограмме AutoCAD 2008.
При запуске AutoCAD создается новый неименованный рисунок. Можно либо начать

создавать в нем объекты, либо загрузить с диска один из уже имеющихся файлов.
При открытии ранее подготовленного имеющегося рисунка всем системным переменным

присваиваются значения, которые они имели в ходе последнего сеанса работы с ним. Это про-
исходит благодаря тому, что переменные сохраняются в файле вместе с рисунком.

Если же вы начинаете работу «с нуля», следует предварительно задать ряд устано-
вок. Обычно это делается автоматически с помощью Мастера подготовки Wizard Description.
AutoCAD позволяет менять установки и в ходе сеанса, если возникает такая необходимость.
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Начало работы

 
После запуска AutoCAD выводится диалоговое окно начала работы Startup (рис. 1.1).
В диалоговом окне Startup пользователю предлагается четыре кнопки, в зависимости от

выбора которых меняется содержимое диалогового окна.

Open a Drawing – для открытия ранее созданного чертежа. Позволяет выбрать из списка
один из рисунков, открывавшихся последними, и загрузить его в AutoCAD. Чтобы загрузить
файл, отсутствующий в списке, следует нажать кнопку обзора Browse….

Start from Scratch – для создания чертежа, где устанавливаются только единицы измере-
ния в области Default Settings: британские (футы и дюймы) или метрические (миллиметры):

• Imperial (feet and inches) – создание нового рисунка, который использует британскую
систему единиц измерения по шаблону acad.dwt. При этом область рисования, называемая еще
лимитами рисунка, устанавливается равной 12x9 дюймов;

• Metric – создание нового рисунка, использующего метрическую систему единиц изме-
рения по шаблону acadiso. dwt. При этом область рисования устанавливается равной 429 х 297
мм.
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Рис. 1.1. Диалоговое окно начала работы

Use a Template – для создания чертежа по шаблону – документу, установки которого
используются как основа для нового рисунка. В области Select a Template: выбирается шаблон,
содержащий необходимые установки черчения. В списке перечисляются имена файлов шаб-
лонов с расширением DWT, которые найдены по стандартному пути, заданному в диалоговом
окне настроек Options. В шаблонах определяются различные параметры рисунка, в том числе
наборы специально созданных слоев, типов линий и видов.

Use a Wizard – вызов Мастера для установки параметров нового чертежа. В области
Select a Wizard: предлагается два режима автоматической настройки рабочей среды AutoCAD
– детальная подготовка Advanced Setup и быстрая подготовка Quick Setup:

• диалоговое окно детальной подготовки Advanced Setup позволяет выполнить полную
установку параметров рабочей среды AutoCAD: назначить единицы измерения длины Units
и угла Angle, задать начало отсчета угла Angle Measure и направление его измерения Angle
Direction, определить границы области рисунка Area;
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• диалоговое окно быстрой подготовки Quick Setup позволяет выполнить быструю уста-
новку параметров рабочей среды AutoCAD: выбрать единицы измерения длины Units и опре-
делить границы области черчения Area.

Диалоговое окно начала работы Startup вызывается при каждой загрузке сеанса AutoCAD
только один раз. В дальнейшем для создания рисунков в уже запущенном сеансе AutoCAD
открывается диалоговое окно создания нового рисунка Create New Drawing.
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Подробнее о шаблоне

 
Установленный набор параметров сеанса можно сделать доступным и для рисунков,

создаваемых впоследствии. Для этого следует сохранить документ как шаблон. Шаблон обычно
представляет собой рисунок, не содержащий никаких графических объектов и используемый
только для хранения стандартных значений системных переменных.

Шаблоны (файлы с расширением DWT)  – весьма удобное средство создания набора
рисунков с однотипными настройками. Можно использовать как шаблоны, поставляемые с
AutoCAD, так и созданные пользователем. Любой имеющийся рисунок можно сохранить в
качестве шаблона. В этом случае значения всех параметров настройки сохраняемого доку-
мента будут наследоваться всеми создаваемыми на его основе новыми рисунками.

Хотя в качестве шаблона подойдет любой рисунок, лучше всего подготовить набор стан-
дартных шаблонов, где представлены чаще всего используемые установки и базовые элементы:

• тип и точность представления единиц;
• лимиты рисунка;
• настройки режимов шага SNAP, сетки GRID и ортогонального режима ORTHO;
• организация слоев;
• основные надписи, рамки и логотипы;
• размерные и текстовые стили;
• типы и веса (толщины) линий.
Никакие изменения, вносимые в рисунок, созданный на основе шаблона, на сам шаблон

не распространяются.
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Вызов справочной системы

 

В любой момент работы с AutoCAD вы можете получить доступ к электронной доку-
ментации по программе. Для этого необходимо выбрать в падающем меню пункт Help. Аль-
тернативный вариант – нажать клавишу F1 на функциональной клавиатуре, ввести символ?
в командной строке или щелкнуть на пиктограмме со значком вопроса на стандартной панели
инструментов.
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Открытие рисунков

 
Программа AutoCAD по умолчанию записывает внутреннее представление рисунка в

файл с расширением DWG. Кроме рисунка файл содержит ряд параметров, определяющих
значения переключателей режимов шага SNAP, сетки GRID, ортогонального режима ORTHO;
принятые единицы измерения и точность представления; границы рисунка; организацию
слоев; форматы и логотипы; размерные и текстовые стили; типы линий и т. п.

AutoCAD предлагает многооконную среду проектирования Multiple Design Environment
(MDE), которая допускает одновременное открытие нескольких чертежей. В одном сеансе
работы можно открывать неограниченное количество рисунков, не жертвуя при этом произ-
водительностью. Среда MDE позволяет перетаскивать объекты, копировать их свойства, такие
как цвет, слой, тип линии, из одного рисунка в другой. Она обеспечивает параллельную работу
с несколькими рисунками, не прерывая выполнения текущей команды и не нарушая последо-
вательности действий. Это существенно упрощает выполнение многих операций и повышает
эффективность работы.

Открыть существующий рисунок можно с помощью команды OPEN, которая вызывается
из падающего меню File → Open… или щелчком на пиктограмме Open…CTRL+О на стан-
дартной панели инструментов.

После обращения к команде OPEN на экране AutoCAD появляется диалоговое окно
выбора файла Select File (рис. 1.2). Здесь можно выбрать имя файла из списка или ввести это
название в поле File name:.

При выделении в списке одного из файлов в области Preview появляется соответствую-
щий образец рисунка. Нажатие кнопки Views выводит список, изменяя параметры которого
пользователь может выбрать форму представления файлов, предлагаемых для открытия: спи-
сок, таблицу, образцы.
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Рис. 1.2. Диалоговое окно выбора файла

Режим открытия файлов – Open (открыть), Open Read-Only (открыть для чтения), Partial
Open (открыть частично), Partial Open Read-Only (открыть для чтения частично) – устанавли-
вается в списке при нажатии стрелки справа от кнопки Open. Частичное открытие позволяет
загружать только те объекты рисунка, которые принадлежат определенным слоям или видовым
экранам. Это оказывается полезным при работе с большими файлами.

Для открытия нескольких рисунков одновременно следует выбрать необходимые файлы
в диалоговом окне Select File, используя клавишу Shift или Ctrl.

Кроме того, рисунки можно открывать путем перетаскивания из Проводника Windows.
Для этого один или несколько выделенных в дереве Проводника файлов следует перетащить
с помощью мыши в любую часть окна AutoCAD, за исключением области рисунка, например
на командную строку или в ту часть панелей инструментов, которая не занята кнопками. Если
же перетащить один файл в область рисования уже открытого рисунка, то произойдет вставка
содержимого перетаскиваемого документа в текущий рисунок в качестве внешней ссылки.

Для открытия рисунка можно дважды щелкнуть на имени соответствующего файла в
Проводнике Windows, что приведет к автоматическому запуску AutoCAD. Если же в системе
уже ведется сеанс работы в AutoCAD, то рисунок откроется в нем.

В AutoCAD имеется специальное средство просмотра небольших фрагментов рисунков,
открытия файлов рисунков и их поиска. Его можно использовать для поиска файлов в струк-
туре папок на одном или нескольких дисках.

Для загрузки диалогового окна просмотра и поиска файлов Find, показанного на рис. 1.3,
необходимо в диалоговом окне Select File последовательно щелкнуть на кнопках Tools →
Find….
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Рис. 1.3. Диалоговое окно просмотра и поиска файлов

На вкладке Name & Location диалогового окна Find указываются имя, расширение и
область поиска файла.

AutoCAD разрешает выполнять поиск файлов по датам их создания, пользуясь вкладкой
Date Modified диалогового окна Find (рис. 1.4). Здесь организуется поиск файлов, созданных
или измененных в период между двумя указанными датами либо за определенное количество
последних дней или месяцев. Имена найденных документов отображаются в нижней части
диалогового окна.
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Рис. 1.4. Вкладка поиска файлов

Рисунки, созданные в AutoCAD любой предшествующей версии, открываются как любой
документ версии 2008 и автоматически преобразуются в новый формат.
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Создание рисунков

 
При создании рисунка могут использоваться различные стандарты. Иногда они дик-

туются государственными и отраслевыми стандартами или нормами предприятия, иногда –
требованиями заказчика. Ключевой момент как для непосредственных исполнителей, так и
для руководителей групп, контролирующих ход выполнения проекта, – грамотная подготовка
начальных параметров рисунка.

Рассмотрим в качестве примера архитектурный проект. Он может включать в себя мно-
жество разделов: планы этажей, схемы сетей водоснабжения, канализации, отопления, венти-
ляции и т. п. Обычно каждый раздел проекта разрабатывается в отдельном подразделении,
поэтому здесь остро встает проблема унификации. Наиболее грамотное ее решение – обеспе-
чение всех исполнителей файлами шаблонов, настроенными на используемую систему единиц
и содержащими стандартные рамку, основную надпись, слои и типы линий.

Не менее важно, какие стили используются для текстовых надписей, штрихования и нане-
сения размеров. Их также следует задавать заранее: это дает гарантию, что каждый проекти-
ровщик будет действовать без отклонения от оговоренных стандартов.

Следует ответственно подходить к выбору рабочего масштаба. Только четкое представ-
ление о том, как соотносятся единицы рисунка на экране и единицы чертежа, выводимого на
плоттер, позволяет правильно выбрать высоту текста для пояснительных надписей и размеров.

Хотя компоновка чертежа обычно производится на последних стадиях проектирования,
грамотное планирование на предварительных этапах позволяет избежать многих ошибок и
избавить персонал от излишних операций редактирования. При создании проекта работа, как
правило, ведется в пространстве модели (здесь объекты представляются в натуральную вели-
чину), а для компоновки чертежа выполняется переход в пространство листа, где ко всем гра-
фическим объектам, текстам, типам линий и размерам применяется необходимый масштаб-
ный коэффициент.

Все начальные установки рисунка могут быть сохранены в шаблоне для последующего
использования в других документах. В качестве шаблона могут применяться как рисунки,
поставляемые с AutoCAD, так и любые другие, в том числе созданные пользователем. Новый
рисунок наследует всю информацию из используемого шаблона. Имеется также возможность
запускать AutoCAD без шаблона.

Создать новый рисунок позволяет команда NEW, вызываемая из падающего меню File
→ New… или щелчком на пиктограмме QNew на стандартной панели инструментов.

После запуска команды необходимые настройки параметров рабочей среды AutoCAD
производятся в диалоговом окне создания нового рисунка Create New Drawing – рис. 1.5.
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Рис. 1.5. Диалоговое окно создания нового рисунка

При создании рисунка по простейшему шаблону используется пиктограмма Start from
Scratch. В данном режиме устанавливается британская или метрическая система единиц.
Важно, что значения многих системных переменных, принятые по умолчанию, зависят от того,
какая из двух систем выбрана. Эти переменные управляют текстом, размерами, сеткой, режи-
мами привязки, а также устанавливают действующие по умолчанию тип линий и файл образ-
цов штриховки:

• Imperial (feet and inches) – создается рисунок, который использует британскую систему
единиц измерения (футы и дюймы), по шаблону acad. dwt. При этом область рисования, иначе
называемая лимитами рисунка, устанавливается равной 12x9 дюймов;

• Metric – создается рисунок, где используется метрическая система единиц измерения,
по шаблону acadiso.dwt. При этом устанавливается область рисования 429 х 297 мм.

Чтобы создать рисунок с использованием шаблона, необходимо в диалоговом окне Create
New Drawing щелкнуть на пиктограмме Use a Template и в списке Select a Template: указать
нужный шаблон (рис. 1.6).
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Рис. 1.6. Выбор шаблона рисунка

В AutoCAD имеется так называемый Мастер подготовки Wizard – служебное средство
для создания нового рисунка. С помощью Мастера подготовки можно, взяв за основу теку-
щий шаблон, модифицировать некоторые базовые установки. Например, пользователь может
автоматически настраивать масштабные коэффициенты для текста в зависимости от общих
размеров рисунка. Если рисунки крупные, выбирается большая высота символов, если мелкие
– меньшая; таким образом обеспечивается разборчивость текстовых надписей, когда рисунок
отображается на экране целиком.

Для вызова Мастера подготовки необходимо в диалоговом окне Create New Drawing
щелкнуть на пиктограмме Use a Wizard – откроется окно, показанное на рис. 1.7.



Т.  Ю.  Соколова.  «AutoCAD 2008 для студента: популярный самоучитель»

22

Рис. 1.7. Создание нового рисунка с помощью Мастера подготовки

Мастер быстрой подготовки QuickSetup (рис. 1.8) позволяет задать для нового рисунка
единицы измерения Units и область рисования Area. Поддерживаются следующие типы еди-
ниц для рисования и вычерчивания: десятичные – Decimal, инженерные – Engineering, архи-
тектурные – Architectural, дробные – Fractional, научные – Scientific.

Рис. 1.8. Диалоговое окно Мастера быстрой подготовки
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Указывая ширину Width и длину Length области рисования, пользователь тем самым
задает граничные пределы рисунка, так называемые лимиты. Именно лимитами определяется
размер чертежа, впоследствии выводимого на плоттер. После того как все параметры заданы,
Мастер быстрой подготовки запускает сеанс рисования в пространстве модели.

Мастер детальной подготовки Advanced Setup (рис.  1.9) позволяет задать для нового
рисунка тип линейных единиц измерения Units и способ измерения углов Angle, указать начало
отсчета угла Angle Measure и направление измерения угла Angle Direction, определить границы
области рисунка Area. В отличие от Мастера быстрой подготовки, который настраивает только
пространство модели, Мастер детальной подготовки воздействует как на пространство модели,
так и на пространство листа.

Рис. 1.9. Диалоговое окно Мастера детальной подготовки

Любая из установок, произведенных в начале рисования, в дальнейшем может быть изме-
нена.
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Определение границ рисунка

 
Команда LIMITS позволяет установить границы текущего рисунка в пространстве

модели и в пространстве листа. Она вызывается из падающего меню Format → Drawing Limits.
В AutoCAD границы рисунка выполняют две функции: определяют диапазон изменения коор-
динат точек и контролируют фрагмент рисунка, покрытый видимой координатной сеткой.

Границы рисунка – это пара двумерных точек в мировой системе координат: координаты
левого нижнего и правого верхнего углов, определяющие прямоугольную область. По оси Z
границы не устанавливаются.

Запросы команды LIMITS:
Reset Model space limits: – переустановка лимитов пространства модели
Specify lower left corner or [ON/OFF] <current>: – левый нижний угол
Specify upper right corner <current>: – правый верхний угол
где:
•  ON – включается контроль соблюдения границ. При этом AutoCAD отвергает все

попытки ввести точки с координатами, выходящими за границы рисунка;
• OFF – отключается контроль соблюдения границ рисунка;
• <current> – текущее значение.
Если текущее значение границ рисунка вас устраивает, достаточно нажать клавишу Enter.
Лимиты должны полностью охватывать полномасштабную модель. Например, если ее

размеры 100 х 200 мм, значения лимитов должны слегка превышать эти цифры.
В пространстве листа лимиты обычно задают равными формату листа бумаги. Следова-

тельно, сетка (если она включена) покрывает при этом весь скомпонованный чертеж, включая
графические объекты, размерные элементы, основную надпись и т. п. Например, если фор-
мат листа равен 210 х 297 мм, следует установить десятичный формат единиц и определить
лимиты указанием точек 0, 0 для левого нижнего угла прямоугольника и210,297– для правого
верхнего угла.

Если в пространстве листа отображаются поля листа или подложен заданный формат,
нельзя задать границы рисунка с помощью команды LIMITS. В этом случае лимиты вычисля-
ются и устанавливаются в зависимости от размеров выбранного листа. Включение и отключе-
ние отображения полей и разметки листа производятся на вкладке Display диалогового окна
Options.

В пространстве модели лимиты могут быть заданы при создании нового рисунка с помо-
щью Мастера быстрой подготовки или Мастера детальной подготовки.
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Определение параметров сетки

 
Сеткой называется упорядоченная последовательность точек, покрывающих область

рисунка в пределах лимитов. Работа в режиме GRID подобна наложению на рисунок листа
бумаги в клетку. Использование сетки помогает выравнивать объекты и оценивать расстояние
между ними. Сетку можно включать и отключать в ходе выполнения других команд. На печать
она не выводится.

Включение сетки и определение ее частоты осуществляется на вкладке Snap and Grid диа-
логового окна режимов рисования Drafting Settings (рис. 1.10), которое загружается из падаю-
щего меню Tools → Drafting Settings… или при выборе пункта настройки Settings… контекст-
ного меню, вызываемого щелчком правой кнопки мыши на кнопке GRID в строке состояния.

Рис. 1.10. Диалоговое окно определения параметров сетки и шага привязки

Сетка включается при установке флажка Grid On (F7). В области Grid spacing устанавли-
вается частота горизонтальных и вертикальных делений сетки, то есть шаг сетки по осям X и
Y. Это осуществляется в текстовых полях Grid X spacing: и Grid Y spacing: соответственно. В
поле Major line every: устанавливается шаг основной линии.



Т.  Ю.  Соколова.  «AutoCAD 2008 для студента: популярный самоучитель»

26

В области Grid behavior определяется режим сетки: Adaptive grid – настройка сетки,
Allow subdivision below grid spasing – разрешение дробления мельче шага сетки, Display grid
beyond Limits – показать сетку за лимитами, Follow Dynamic UCS – следовать динамической
ПСК.

При работе с рисунком включать и отключать сетку следует щелчком на кнопке GRID в
строке состояния или нажатием функциональной клавиши F7.

После зумирования рисунка для лучшего согласования с новым коэффициентом экран-
ного увеличения может потребоваться изменение частоты сетки.
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Определение шага привязки

 
В режиме шаговой привязки SNAP курсор может находиться только в определенных

точках согласно установленному значению шага и при этом движется не плавно, а скачкооб-
разно между узлами воображаемой сетки, как бы «прилипая» к ним. Активность режима шаго-
вой привязки SNAP можно определить визуально, по скачкообразному движению курсора на
экране. Шаговая привязка обычно используется для точного указания точек с помощью мыши.
Интервал привязки задается отдельно по осям XnY. Включение и отключение режима шаговой
привязки может производиться в ходе выполнения команды.

Шаг привязки не обязательно совпадает с частотой сетки. Сетку часто делают достаточно
редкой, используя ее исключительно для наглядности, а шаг привязки устанавливают мень-
шим. Допустимо и обратное: установка большего по сравнению с сеткой шага привязки.

Включение шаговой привязки SNAP и настройка ее параметров осуществляются на
вкладке Snap and Grid диалогового окна режимов рисования Drafting Settings, которое загру-
жается из падающего меню Tools → Drafting Settings… или при выборе пункта Settings… из
контекстного меню, вызываемого щелчком правой кнопки мыши на кнопке SNAP в строке
состояния (см. рис. 1.10).

Шаговая привязка включается при установке флажка Snap On (F9). В области Snap
spacing задается шаг привязки по горизонтали и вертикали. Это осуществляется в текстовых
полях Snap X spacing: и Snap Y spacing: соответственно.

Параметром Equal X and Y spacing устанавливается равный шаг по осям X и Y. В области
Polar spacing устанавливается шаг полярной привязки.

Тип привязки устанавливается в области Snap type. Grid snap – шаговая привязка
(Rectangular snap – ортогональная, Isometric snap – изометрическая), PolarSnap – полярная
привязка.

При работе с рисунком включать и отключать шаговую привязку следует щелчком на
кнопке SNAP в строке состояния или нажатием функциональной клавиши F9.

Совет
Выполните упражнение L4 из раздела 2.
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Сохранение рисунков

 

Команда сохранения рисунка QSAVE вызывается из падающего меню FileSave или щелч-
ком на пиктограмме Save CTRL+S на стандартной панели инструментов. Команда QSAVE
используется в тех случаях, когда уже существующий рисунок сохраняется без изменения его
имени. Если рисунок новый и его имя не определено, то QSAVE действует так же, как команда
SAVEAS.

Команды SAVE и SAVEAS предназначены для сохранения рисунка под другим именем.
Команда SAVE может вызываться только из командной строки, a SAVEAS – из падающего
меню File → Save As…. В обоих случаях имя документа задается в поле File name: диалогового
окна Save Drawing As – рис. 1.11.

Рис. 1.11. Диалоговое окно сохранения рисунка

Предыдущей копии рисунка на диске присваивается расширение ВАК вместо DWG. Все
предыдущие ВАК-файлы с данным именем удаляются. Обновленный рисунок записывается с
расширением DWG. Если при указании имени файла оказывается, что рисунок с таким назва-
нием уже существует, выдается предупреждение и предоставляется возможность перезаписать
файл или ввести другое имя.

Любой рисунок можно сохранить как шаблон. Для этого в раскрывающемся списке Files
of type: диалогового окна Save Drawing As необходимо выбрать пункт AutoCAD Drawing
Template (*.dwt).
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Чтобы обеспечить автоматическое сохранение рисунка через заданные интервалы вре-
мени, следует использовать системную переменную SAVETIME или вкладку Open and Save
диалогового окна Options. Оно вызывается из падающего меню Tools → Options…. В послед-
нем случае необходимо поставить флажок автосохранения Automatic save в области File Safety
Precautions и установить значение интервала в минутах между автосохранениями в поле
Minutes between saves.
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Получение твердой копии рисунка

 
Распечатка чертежа – последний этап при работе с рисунком. Перед выводом рисунка

на печать необходимо его скомпоновать, то есть определить, какие виды должны быть вычер-
чены. Работа над рисунком ведется на разных этапах либо в пространстве модели, либо в про-
странстве листа. Пространство модели предназначено для создания модели – изображения в
реальном масштабе. Пространство листа представляет собой аналог листа бумаги, на кото-
ром производится создание и размещение видов перед вычерчиванием.

Как в пространстве модели, так и в пространстве листа может быть один или несколько
видовых экранов, на которых представлены различные виды модели. Компоновка чертежа, по
сути дела, представляет собой процесс создания и размещения таких экранов. По завершении
компоновки чертеж выводится на принтер или плоттер.

Перед выводом рисунка на плоттер можно предварительно просмотреть, как он будет
размещаться на листе бумаги. Для этого используется команда предварительного просмотра
PREVIEW, вызываемая из падающего меню File → Plot Preview или щелчком на пиктограмме
Plot Preview на стандартной панели инструментов. При этом автоматически включается изме-
нение масштаба изображения в режиме реального времени для просмотра мелких деталей
чертежа. Для изменения режима масштаба изображения, вывода на плоттер, использования
панорамирования или выхода из предварительного просмотра используется контекстное меню
(рис. 1.12), которое вызывается в ответ на щелчок правой кнопкой мыши.

Рис. 1.12. Контекстное меню

Все установки вывода рисунка на плоттер осуществляются в диалоговом окне Plot –
Model (рис. 1.13). Это окно загружается командой PLOT, вызываемой из падающего меню File
→ Plot… или щелчком на пиктограмме Plot.. CTRL+P на стандартной панели инструментов.

В диалоговом окне Plot – Model делаются следующие назначения.
• В области Page setup устанавливается набор параметров листа. Кнопкой Add… откры-

вается диалоговое окно добавления набора параметров листа.
• В области Printer/plotter устанавливаются параметры:
– из списка Name: выбирается устройство вывода;
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– кнопка Properties… загружает редактор параметров плоттера;
– установкой флажка Plot to file назначается печать в файл.
• В области Paper size определяется формат.
• В области Number of copies устанавливается количество экземпляров.
•  В области Plot area устанавливается печатаемая область: Display – экран, Limits –

лимиты, Window – рамка.
• В области Plot offset (origin set to printable area) определяется смещение печатаемой

области по X и Y, а также центрированность.
• В области Plot scale определяется масштаб печати и веса линий:
– Fit to paper – вписать;
– Scale: – масштаб;
– Scale lineweights – масштабировать веса линий.

Рис. 1.13. Диалоговое окно вывода на печать пространства модели

• В области Plot style table (pen assignments) определяется таблица стилей печати.
• В области видовых экранов с раскрашиванием Shaded viewport options определяется:
– Shade plot – способ вывода (как на экране, каркас, скрытие линий; 3D-скрытый, 3D-кар-

кас, концептуальный, реалистичный; тонирование, черновое, низкое, среднее, высокое, пре-
зентационное);

–  Quality – качество (черновое, просмотр, нормальное, презентационное, максимум,
пользовательское).

• В области Plot options определяются параметры печати:
– Plot in background – печатать в фоновом режиме;
– Plot object lineweights – учитывать веса линий;
– Plot with plot styles – учитывать стили печати;
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– Plot paperspace last – объекты листа последними;
– Hide paperspace objects – скрывать объекты листа;
– Plot stamp on – включить штемпель;
– Save changes to layout – сохранить параметры.
• В области Drawing orientation определяется ориентация чертежа:
– Portrait – книжная;
– Landscape – альбомная;
– Plot upside-down – перевернутая.
• Кнопка Preview… загружает окно предварительного просмотра.
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Выход из AutoCAD

 
Для выхода из AutoCAD используется команда QUIT, которая вызывается из падающего

меню File → Exit CTRL+Q.
Команда позволяет сохранить или проигнорировать сделанные в рисунке изменения и

выйти из AutoCAD. Если все выпоненные изменения сохранены, при выходе из программы не
появится никаких дополнительных сообщений. В противном случае на экран будет выведено
диалоговое окно AutoCAD (рис. 1.14), предлагающее пользователю выбор: сохранить измене-
ния, отказаться от них или продолжить сеанс работы.

Рис. 1.14. Диалоговое окно сохранения изменений в рисунке

Если текущему рисунку не было присвоено имя и вы хотите его сохранить, откроется
диалоговое окно Save Drawing As.
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Глава 2

Пользовательский интерфейс AutoCAD
 

На рис. 2.1. показан классический рабочий стол AutoCAD для Windows.

Рис. 2.1. Рабочий стол AutoCAD

В данный рабочий стол включены:
•  падающие меню – верхняя строка, расположенная непосредственно под заголовком

окна программы;
• необязательные панели инструментов:
– стандартная панель Standard и панель стилей Styles – вторая строка от заголовка;
– панель рабочих пространств Workspaces, слоев Layers и свойств Properties – третья

строка;
– панель рисования Draw и редактирования Modify – столбцы слева;
• строка состояния – строка внизу окна программы;
• окно командных строк – выше строки состояния;
• графическое поле, занимающее остальную часть рабочего стола.
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Падающие меню

 
Строка падающих меню может быть изменена путем добавления либо удаления тех или

иных пунктов. Для этого необходимо выбрать в падающем меню пункты Tools → Customize →
Interface…, в появившемся диалоговом окне настройки интерфейса пользователя Customize
User Interface на вкладке Customize, в области Customizatios in All CUI Files раскрыть пункт
Menus (рис. 2.2). Далее установить указатель мыши на один из пунктов меню и, щелкнув пра-
вой кнопкой мыши, вызвать контекстное меню, в котором выбрать соответствующий пункт
для удаления имеющихся или создания новых падающих меню.

Рис. 2.2. Диалоговое окно адаптации меню

Строка падающих меню по умолчанию содержит следующие пункты:
•  File – команды работы с файлами: создание, открытие, сохранение, публикация в

Интернете, печать, экспорт файлов в другие форматы, а также диспетчеры параметров листов,
плоттеров, стилей печати и пр.;

• Edit – инструменты для редактирования частей графического поля рабочего стола про-
граммы, работы с буфером обмена и пр.;
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•  View – управление экраном, зумирование, панорамирование, установка трехмерной
точки зрения, создание видовых экранов и именованных видов, установка визуальных стилей,
тонирование, анимация траектории перемещения, установка необходимых панелей инструмен-
тов;

• Insert – команды вставки блоков, внешних объектов, объектов других приложений;
• Format – команды работы со слоями и их инструментами; цветом, типами линий; управ-

ление стилями текста, размеров, мультилиний, таблиц; видом маркера точки; установки еди-
ниц измерения, границ чертежа;

•  Tools – управление рабочими пространствами; палитрами; установка порядка про-
рисовки объектов и получение сведений о них; работа с блоками и их атрибутами; работа
с языком AutoLISP; работа с пользовательской системой координат; настройка стандартов
оформления; управление Мастерами (публикации в Интернете, установки плоттеров, создания
таблиц стилей печати, цветозависимых стилей печати, компоновки листа, создания подшивки,
импорта параметров печати); установка параметров черчения и привязок с помощью диалого-
вых окон и пр.;

• Draw – команды двумерного и трехмерного рисования;
• Dimension – команды простановки размеров и управления параметрами размерных сти-

лей;
• Modify – команды редактирования элементов чертежа;
• Window – многооконный режим работы с чертежами;
• Help – вывод на экран системы гипертекстовых подсказок.
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Панели инструментов

 
Команды AutoCAD на панелях инструментов представлены в виде пиктограмм. Если

задержать указатель мыши на пиктограмме, рядом с ней появляется название соответствую-
щей команды, помещенное в маленький прямоугольник.

Если в правом нижнем углу пиктограммы изображен маленький черный треугольник,
это значит, что она содержит подменю с набором родственных команд. Для вызова подменю
необходимо на некоторое время задержать на пиктограмме указатель мыши, нажав ее левую
кнопку.

Панели инструментов могут быть плавающими (float) или закрепленными (dock), с фик-
сированным местоположением. Допускаются изменения размеров плавающих панелей, а также
их перемещение по графическому полю (рис. 2.3). Плавающую панель можно сделать закреп-
ленной, перетащив ее с помощью мыши за пределы графического поля. И наоборот, как только
закрепленная панель попадает в область графического поля, она превращается в плавающую.

Рис. 2.3. Плавающая панель инструментов

При необходимости требуемую панель инструментов можно вывести на рабочий стол,
щелкнув левой кнопкой мыши на ее имени в списке контекстного меню. Для открытия этого
контекстного меню необходимо щелкнуть правой кнопкой мыши, установив ее указатель на
любую пиктограмму панелей инструментов (рис. 2.4).
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Рис. 2.4. Список панелей инструментов
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Для удаления панели инструментов необходимо сделать ее плавающей, если она закреп-
лена, и щелкнуть на кнопке закрытия, расположенной в правом верхнем углу заголовка панели.

Если набор необходимых панелей и окон упорядочен на рабочем столе, во избежание их
случайного перемещения или удаления пользователь может зафиксировать их положение. Для
этого следует вызвать контекстное меню щелчком правой кнопки мыши на инструменте, изоб-
ражающем замочек, в правой части строки состояния и зафиксировать положение панелей:

• Floating Toolbars – плавающие панели инструментов;
• Docked Toolbars – закрепленные панели инструментов;
• Floating Windows – плавающие окна;
• Docked Windows – закрепленные окна;
• Аll – все инструменты: Locked – заблокированы, Unlocked – разблокированы;
• Help – справка.
Чтобы временно разблокировать панели инструментов, необходимо удерживать нажатой

клавишу Ctrl.
Совет
Выполните упражнение N3 из раздела 1.
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Стандартная панель инструментов

 
Стандартная панель Standard показана на рис. 2.5.

Рис. 2.5. Стандартная панель инструментов

Она содержит следующие инструменты:

Qnew – создание нового файла рисунка;

Open… CTRL+0 – загрузка существующего файла;

Save CTRL+S – сохранение текущего файла;

Plot… CTRL+P – вывод рисунка на плоттер, принтер или в файл;

Plot Preview – предварительный просмотр чертежа перед выводом на печать, позволяю-
щий увидеть размещение чертежа на листе бумаги;

Publish… – публикация листов чертежа в формате файла Design Web Format (DWF),
загрузка диалогового окна Publish;
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3DDWF – экспорт трехмерной модели в формате файла Design Web Format (DWF);

Cut CTRL+X – копирование объектов в буфер обмена с удалением их из рисунка;

Copy CTRL+C – копирование выбранных элементов чертежа в буфер Windows без уда-
ления их из исходного документа;

Paste CTRL+V – вставка данных из буфера Windows;

Match Properties – копирование свойств заданного объекта другому объекту;

Block Editor – редактирование блоков;

Undo – отмена последнего действия;

Redo – восстановление только что отмененного действия;

Pan Realtime – перемещение изображения на текущем видовом экране в режиме реаль-
ного времени;



Т.  Ю.  Соколова.  «AutoCAD 2008 для студента: популярный самоучитель»

43

Zoom Realtime – увеличение или уменьшение видимого размера объектов на текущем
видовом экране в режиме реального времени;

Подменю Zoom – раскрывающийся набор инструментов, в котором можно задать раз-
личные способы увеличения и уменьшения видимого размера объектов на текущем видовом
экране;

Zoom Previous – возврат к показу предыдущего вида;

Properties CTRL+1 – загрузка палитры управления свойствами объектов;

DesignCenter CTRL+2 – диалоговый интерфейс, позволяющий быстро находить, про-
сматривать, вызывать, переносить в текущий рисунок ранее созданные рисунки, управлять
вхождениями блоков, внешними ссылками и другими элементами рисунков, такими как слои,
листы и текстовые стили;

Tool Palettes Window CTRL+3 – инструментальные палитры в виде отдельных вкладок
специального окна, которые служат эффективным средством хранения/вставки блоков и штри-
ховки. Палитры могут содержать инструменты, предоставленные сторонними разработчиками;

Sheet Set Manager CTRL+4 – диспетчер подшивок наборов листов, позволяющий органи-
зовать размещение пакетов листов в зависимости от типа чертежей и с возможностью эффек-
тивного создания, управления и совместного использования наборов логически связанных
рисунков;
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Markup Set Manager CTRL+7 – диспетчер наборов пометок, позволяющий организовать
работу с рисунками формата DWF;

QuickCalc CTRL+8 – калькулятор;

Help – вызов справочной системы.
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Панель стилей

 
Панель стилей Styles, показанная на рис. 2.6, предназначена для создания новых тексто-

вых, размерных и табличных стилей.

Рис. 2.6. Панель стилей

Панель содержит следующие инструменты:

Text Style… – создание новых и редактирование имеющихся текстовых стилей;

Dimension Style… – создание новых и редактирование имеющихся размерных стилей;

Table Style… – создание новых и редактирование имеющихся табличных стилей;

Multileader Style… – создание новых и редактирование имеющихся стилей линий-выно-
сок.
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Панель рабочих пространств

 
Панель Workspaces, показанная на рис. 2.7, размещается на рабочем столе под стандарт-

ной па нелью инструментов и позволяет задавать параметры рабочих пространств.

Рис. 2.7. Панель рабочих пространств

Рабочие пространства включают только необходимые наборы меню, инструментальные
панели и палитры, сгруппированные и упорядоченные соответственно решаемой задаче. Эле-
менты интерфейса, не являющиеся необходимыми для решения текущей задачи, скрываются,
максимально освобождая область экрана, доступную для работы.

В AutoCAD определены следующие рабочие пространства:
• 2D Drafting & Annotation – двумерное моделирование;
• 3D Modeling – трехмерное моделирование;
• AutoCAD Classic – классический AutoCAD.
Помимо возможности установить рабочее пространство в панель Workspaces включены

следующие пункты, осуществляющие:
• Save Current As… – открытие диалогового окна Save Workspace, позволяющего сохра-

нить текущее рабочее пространство;
• Workspace settings… – открытие диалогового окна Workspace Settings, позволяющего

настроить текущие параметры рабочего пространства для последующего использования;
• Customize… – открытие диалогового окна Customize User Interface, позволяющего осу-

ществить настройки интерфейса пользователя.
Кроме того, панель Workspaces содержит следующие инструменты:

Workspace Settings…  – открытие диалогового окна Workspace Settings, позволяющего
настроить текущие параметры рабочего пространства для последующего использования;

My Workspace – возвращение имени текущего рабочего пространства в интерфейс
командной строки и установление этого пространства текущим.
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Рабочее пространство 3D Modeling включает новый пульт управления, обеспечивающий
удобный доступ к новым функциям трехмерного моделирования, в области рисования отоб-
ражается цвет фона, наземная плоскость или рабочая поверхность и новая прямоугольная
сетка, что улучшает трехмерную визуализацию и облегчает создание пространственных моде-
лей. Новый трехмерный курсор обеспечивает указание направления ПСК. Вкладки Model и
Lauout заменены кнопками в строке состояния, благодаря чему расширена область рисования.
На режим отображения вкладок можно переключиться, нажав правую кнопку мыши на кнопке
Model или Lauout.
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Панель слоев

 
Панель слоев Layers, показанная на рис. 2.8, размещается на рабочем столе под стандарт-

ной панелью инструментов и обеспечивает работу со слоями.

Рис. 2.8. Панель слоев

В нее входят следующие инструменты:

Layer Properties Manager – вызов Диспетчера свойств слоев Layer Properties Manager;

Filter applied – раскрывающийся список управления слоями.
Каждая строка содержит пиктограммы управления свойствами слоя или отображения его

свойств, а также его имя. Ниже перечисляются эти пиктограммы (слева направо):
• Turn a layer On or Off – включение/отключение слоя;
• Freeze or thaw in ALL viewports – замораживание/размораживание на всех видовых

экранах;
• Freeze or thaw in current viewport – замораживание/размораживание на текущем видо-

вом экране;
• Lock or Unlock a layer – блокирование/разблокирование слоя;
• Color of layer – цвет слоя;
• Filter applied – имя слоя;

Make Object's Layer Current – установка текущего слоя в соответствии со слоем выбран-
ного примитива;

Layer Previous – возврат к предыдущему состоянию слоев;
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Layer States Manager – загрузка диалогового окна Layer States Manager.
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Панель свойств объектов

 
Панель свойств объектов Properties, показанная на рис.  2.9, размещается на рабочем

столе под стандартной панелью инструментов и предназначена для работы с цветом, типом и
весом линий.

Рис. 2.9. Панель свойств объектов

В нее входят следующие инструменты:

Color Control – раскрывающийся список установки текущего цвета, а также изменения
цвета выбранных объектов;

Linetype Control – раскрывающийся список установки текущего типа линии, а также
изменения типа линии для выбранных объектов;

Lineweight Control – раскрывающийся список установки текущего веса (толщины) линии,
а также изменения толщины линий выбранных объектов;

Plot Styles Control – раскрывающийся список установки стилей печати. Здесь можно
изменять внешний вид вычерчиваемого на плоттере рисунка. В стилях печати при необходи-
мости переопределяются цвета, типы и веса (толщины) линий объектов. Кроме этого, имеется
возможность указывать используемые при печати стили концов линий, соединений и заполне-
ний, а также различные выходные эффекты – размывание, оттенки серого, присвоения перьев
и интенсивность. Манипулируя стилями печати, можно получить на бумаге различные вари-
анты одного и того же рисунка. Допускается применение стилей печати к объектам или слоям.
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Строка состояния

 
Строка состояния (рис. 2.10) расположена в нижней части рабочего стола.

Рис. 2.10. Строка состояния

Она содержит текущие координаты курсора, а также кнопки включения/выключения
режимов черчения:

• SNAP – Snap Mode, включение и выключение шаговой привязки курсора;
• GRID – Grid Display, включение и выключение отображения сетки;
• ORTHO – Ortho Mode, включение и выключение ортогонального режима;
• POLAR – Polar Tracking, включение и выключение режима полярного отслеживания;
• OSNAP – Object Snap, включение и выключение режимов объектной привязки;
• OTRACK – Object Snap Tracking, включение и выключение режима отслеживания при

объектной привязке;
• DUCS – Allow/Disallow Dynamic UCS, включение и выключение динамической поль-

зовательской системы координат;
• DYN – Dynamic Input, включение и выключение динамического ввода;
• LWT – Show/Hide Lineweight, включение и выключение режима отображения линий в

соответствии с весами (толщинами);
• MODEL/PAPER – Model or Paper space, переключение из пространства модели в про-

странство листа.
Отображение кнопок включения/выключения режимов черчения в строке состояния

устанавливается в контекстном меню (рис. 2.11). Для этого необходимо щелкнуть левой или
правой кнопкой на инструменте Status Bar menu с изображением стрелки вниз, который нахо-
дится в правой части строки состояния.
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Рис. 2.11. Контекстное меню настройки строки состояния

Команда Tray Settings… открывает диалоговое окно Tray Settings (рис. 2.12), позволяю-
щее произвести настройку области уведомлений, а именно:

• Display icons from services – показывать значки служб;
• Display notifications from services – показывать уведомления от служб:
– Display time: – время отображения;
– Display until closed – до явного закрытия.

Рис. 2.12. Диалоговое окно настройки области уведомлений
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Окно командных строк

 
Окно командных строк обычно расположено над строкой состояния; оно служит для

ввода команд и вывода подсказок и сообщений AutoCAD. Размеры окна, а следовательно,
количество выводимых строк протокола можно изменять. При наличии в окне команд более
одной строки перемещение по строкам осуществляется с помощью полосы прокрутки.

По умолчанию окно команд закреплено и равно по ширине окну AutoCAD (рис. 2.13).
Если текстовая строка не помещается в окне, ее полное содержимое выводится в рамке вблизи
командной строки.

Рис. 2.13. Закрепленное окно командных строк

Изменить высоту окна можно с помощью разделительной полосы, находящейся в его
верхней части (если оно закреплено внизу) или в нижней (если оно закреплено вверху). Чтобы
изменить размер, следует захватить разделительную полосу с помощью мыши и «отбуксиро-
вать» ее до требуемой высоты.

Окно может быть как закрепленным, так и плавающим. Закрепление отменяется путем
выбора рамки окна в любом месте и последующей буксировки за пределы зоны закрепления
до тех пор, пока граница окна не примет вид широкой контурной линии. Если отпустить окно
в этот момент, оно станет плавающим и приобретет размер, который имело до закрепления.
Плавающее окно может быть перемещено в любую позицию экрана; при этом пользователю
разрешено изменять его ширину и высоту (рис. 2.14).

Рис. 2.14. Плавающее окно командных строк

Закрепляется окно команд путем «буксировки» к верхней или нижней зоне закрепления
окна AutoCAD.

В окне командных строк можно прокручивать текст, выполнять его редактирование и
повторно вводить команды. Для этого используются стандартные клавиши: ↑, ↓, ←, →, Insert,
Delete, Home, End, Page Up, Page Down, Backspace.
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При повторении ранее введенных команд удобно воспользоваться комбинацией клавиш
Ctrl+C, чтобы копировать выделенный текст в буфер обмена, и Ctrl+V, чтобы вставить содер-
жимое буфера в текстовое окно или окно команд.

Щелчок правой кнопкой мыши в области окна командных строк или текстового окна
AutoCAD вызывает контекстное меню, куда входят шесть последних использованных команд,
функции копирования выделенного текста или всего протокола команд, вставки текста, а также
вызова диалогового окна настройки Options.
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Текстовое окно

 
Чтобы просмотреть большую часть протокола команд – так называемую историю команд

(command history), можно переключиться в текстовое окно, показанное на рис. 2.15. Это окно
вызывается нажатием функциональной клавиши F2 или командой TEXTSCR, а также с помо-
щью меню View → Display → Text Window F2.

Рис. 2.15. Текстовое окно

Текстовое окно подобно окну команд: в нем также можно вводить команды, наблюдать
подсказки и сообщения, выдаваемые AutoCAD. Для перемещения по окну используется полоса
прокрутки или клавиши ↑, ↓, ←, →, Page Up и пр.

Содержимое текстового окна предназначено только для чтения и не подлежит измене-
нию. Но протокол команд можно копировать для последующей вставки в командную строку
или текстовый редактор.
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Контекстное меню

 
Для выбора пунктов меню и пиктограмм на панели инструментов часто используется

устройство указания – мышь. При работе с мышью нажатие левой кнопки в области рисования
обычно используется для выбора и указания точки на экране; щелчок правой кнопкой мыши
вызывает контекстное меню, которое обеспечивает быстрый доступ к командам (см. рис. 2.4,
2.16). Форма и содержание меню зависят от положения указателя мыши и состояния задачи.

Рис. 2.16. Пример контекстного меню
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Инструментальные палитры

 

Инструментальные палитры загружаются командой TOOLPALETTES, либо из падаю-
щего меню Tools → Palettes → Tool Palettes CTRL+3, либо щелчком на пиктограмме Tool
Palettes Window CTRL+3 на стандартной панели инструментов.

Инструментальные палитры представляют собой отдельные вкладки, объединенные в
специальном окне TOOL PALETTES (рис. 2.17), и являются эффективным средством хране-
ния и вставки блоков и штриховки, а также могут содержать инструменты, предоставленные
сторонними разработчиками.
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Рис. 2.17. Инструментальная палитра

В разных областях окна инструментальных палитр с помощью контекстных меню можно
изменять следующие настройки:

• автоматически убирать палитры с экрана – окно инструментальных палитр может авто-
матически разворачиваться и сворачиваться при подведении указателя мыши к строке заго-
ловка окна и отведении от нее;

• прозрачность – окно палитры инструментов делается прозрачным и не скрывает нахо-
дящиеся за ним объекты (эта функция недоступна для пользователей Microsoft Windows NT);

• вид – изменяются стиль и размер отображаемых в палитре значков.
Окно инструментальных палитр при необходимости можно закрепить у правой или левой

границы окна программы. Для того чтобы избежать закрепления, при перемещении окна сле-
дует удерживать нажатой клавишу Ctrl.

На палитрах удобно размещать часто используемые блоки и штриховки. Для того чтобы
вставить блок или штриховку из палитры в рисунок, необходимо «захватить» элемент палитры
с помощью мыши и перетащить его в графическую область.

Блоки и штриховки, размещенные на палитре, носят название «инструментов». Некото-
рые свойства инструментов, включая масштаб, угол поворота и слой, могут устанавливаться
отдельно для каждого инструмента.

При перетаскивании блока с инструментальной палитры на рисунок он автоматически
масштабируется в зависимости от соотношения заданных единиц блока и единиц текущего
рисунка. Например, если в качестве единиц измерения данного рисунка используются метры,
а в качестве единиц измерения блока – сантиметры, то коэффициент пересчета составляет 1:
100. Соответственно, при перетаскивании блока в рисунок его размеры меняются в пропорции
1: 100.
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Пульт управления

 
В рабочее пространство 3D Modeling включен новый пульт управления DASHBOARD,

который по умолчанию закреплен с правой стороны области рисования. Он содержит кнопки
и элементы управления, ориентированные на задачи установленного рабочего пространства
(рис. 2.18).

Рис. 2.18. Пульт управления

Пульт управления представляет собой набор управляющих панелей, на которых распо-
ложены соответствующие инструменты и элементы управления, аналогичные инструментам
панелей и элементам управления диалоговых окон.

Слева на пульте отображены значки, обозначающие назначение управляющей панели.
При нажатии на значок открывается текущая всплывающая панель, содержащая дополнитель-
ные инструменты. Более одной всплывающей панели отобразить невозможно, поэтому при
нажатии на другой значок, открытая панель автоматически закрывается.
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Центр управления AutoCAD DesignCenter

 
В практической деятельности очень важно иметь возможность использовать создан-

ные ранее наработки: опыт показывает, что большинство проектно-конструкторских проектов
создается на базе новых сочетаний элементов, давно известных как по принципу функциони-
рования, так и по исполнению. AutoCAD обеспечивает эффективное повторное использова-
ние имеющихся наработок путем их вставки в рисунки в виде блоков или внешних ссылок.
Управлять блоками, внешними ссылками, растровыми изображениями и содержимым рисун-
ков, находящихся в других источниках (и даже подготовленных в других приложениях), поз-
воляет Центр управления AutoCAD DesignCenter.

Кроме того, если в сеансе открыто несколько рисунков, Центр управления дает возмож-
ность упростить процесс создания таких элементов, как, например, описания одних и тех же
слоев. Пользователь создает описание в одном рисунке, а затем просто копирует в остальные.

Центр управления DesignCenter предназначен для организации доступа к чертежам и их
элементам и обеспечивает:

• просмотр содержимого чертежей на локальном диске, сетевом диске и веб-страницах;
• просмотр и вставку в текущий чертеж блоков, слоев, текстовых и размерных стилей,

типов линий, внешних ссылок, образцов штриховки и прочих элементов чертежей;
• доступ к растровым изображениям и сторонним объектам, созданным в других прило-

жениях;
• обновление описания блоков;
• перетаскивание элементов чертежа на инструментальные палитры.

Центр управления AutoCAD загружается командой ADCENTER, либо из падающего
меню Tools → Palettes → DesignCenter CTRL+2, либо щелчком на пиктограмме DesignCenter
CTRL+2 на стандартной панели инструментов (рис. 2.19).
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Рис. 2.19. Центр управления DesignCenter

Центр управления имеет интуитивно понятный интерфейс и позволяет быстро находить,
просматривать, вызывать и применять специфические компоненты, такие как блоки, слои,
типы линий и пр. Причем эти операции осуществляются из открытых или закрытых файлов
AutoCAD, независимо от того, где они находятся: на локальных или удаленных дисках. Доста-
точно просто выбрать нужные компоненты и перетащить их в текущий рисунок.



Т.  Ю.  Соколова.  «AutoCAD 2008 для студента: популярный самоучитель»

63

 
Конец ознакомительного фрагмента.
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